












































	 Home
	 Add Document
	 Sign In
	 Create An Account
































Digitale Signalverarbeitung mittels FPGA









Digitale Signalverarbeitung mittels FPGA Wahlmodul Entwicklung digitaler Systeme
von Philip Ridder
Betreuer: Dipl. –Ing. (FH) Oliver Gießelmann Doze... 




Author:
Kristian Ackermann 




 57 downloads
 2 Views
2MB Size



 Report







 Download PDF 






















































Recommend Documents














Digitale Signalverarbeitung 













 









Digitale Signalverarbeitung auf FPGAs 













 









Seminar Digitale Signalverarbeitung 













 









IV. Digitale Signalverarbeitung 













 









Digitale Signalverarbeitung Vorlesung 5 - Filterstrukturen 













 









D-SERIES Industrielle Relaiskoppler. Digitale Signalverarbeitung 













 









Zeitdiskrete Signalverarbeitung 













 









Neuronale Signalverarbeitung 













 









Basiswissen Signalverarbeitung 













 









Anleitung zum Laborpraktikumsversuch Elektronische Detektorauslese und digitale Datenverarbeitung mit FPGA 













 









Werbemitteldruck mittels. Glasveredelung mittels Siebdruckverfahren 













 









Anhang A zum Buch: Signalverarbeitung. Analoge und digitale Signale, Systeme und Filter. Digitales Transversalfilter (Bandpass) 













 









Signalverarbeitung und Steuerung 













 









Herbert Bernstein. Messelektronik. und Sensoren. Grundlagen der Messtechnik, Sensoren, analoge und digitale Signalverarbeitung. 4^ Springer Vieweg 













 









Werkzeuge der Signalverarbeitung 













 









Grundlagen der Signalverarbeitung und Robotik 













 









Digitale Kopie Digitale Kopie Digitale Kopie Digitale Kopie Digitale Kopie Digitale Kopie Bautechnische Zulassung 













 









Digitale Stadt - digitale Verwaltung 













 









Diskrete Signalverarbeitung und diskrete Systeme 













 









Grundlagen der Signalverarbeitung und Robo7k 













 









Analoge Signalverarbeitung und Filterung (ASF) 













 









Grundlagen der Signalverarbeitung und Robotik 













 









Digitale Medien 7. DIGITALE BILDMANIPULATION 













 









DIGITALE SCHULE BILDUNGSKONGRESS DIGITALE SCHULE 













 
















Digitale Signalverarbeitung mittels FPGA Wahlmodul Entwicklung digitaler Systeme



von Philip Ridder



Betreuer: Dipl. –Ing. (FH) Oliver Gießelmann Dozent: Prof. Dr. Udo Jorczyk



Gelsenkirchen 21.Februar 2017



INHALT 1



EINLEITUNG ............................................................................................. 3



2



SYSTEMBESCHREIBUNG ........................................................................... 3 2.1



SIGNALVERARBEITUNG .................................................................................................................................... 4



3



INBETRIEBNAHME ................................................................................... 5



4



EINRICHTEN DER ENTWICKLUNGSUMGEBUNG ........................................ 6



5



4.1



HERSTELLEN DER SERIELLEN KOMMUNIKATION .................................................................................................... 6



4.2



DATEN PER SSH ÜBERTRAGEN .......................................................................................................................... 8



4.2.1



SSH einrichten.................................................................................................................................. 8



4.2.2



Passwort festlegen .......................................................................................................................... 9



4.2.3



Remote Verbindung einrichten ........................................................................................................ 9



4.3



IP-ADRESSE FESTLEGEN ................................................................................................................................ 12



4.4



FPGA BEIM BOOTEN KONFIGURIEREN.............................................................................................................. 14



WICHTIGE ZUSAMMENHÄNGE ................................................................17 5.1



6



7



SOFTWARE .............................................................................................19 6.1



I2CMUX ..................................................................................................................................................... 19



6.2



AUDIOINITIALIZE .......................................................................................................................................... 20



VHDL ......................................................................................................22 7.1



BUS MULTIPLEXER ....................................................................................................................................... 22



7.2



AUSSTEUERUNGSANZEIGE (METERBRIDGE) ....................................................................................................... 22



7.3



SERIELL ZU PARALLEL WANDLUNG................................................................................................................... 24



7.3.1



Schieberegister .............................................................................................................................. 26



7.3.2



Bitzähler ........................................................................................................................................ 27



7.4



8



QSYS UND ECLIPSE ...................................................................................................................................... 17



PARALLEL ZU SERIELL WANDLUNG................................................................................................................... 30



FILTERDESIGN MIT MATLAB ....................................................................32



2/36



1



Einleitung Dieses Dokument stellt die ergänzende Dokumentation zum Projekt Digitale Signalverarbeitung mittels FPGA dar. Das Projekt ist Teil der Veranstaltung Entwurf digitaler Systeme an der Westfälischen Hochschule Gelsenkirchen aus dem Wintersemester 2016/2018 unter Leitung von Prof. Dr. –Ing. Udo Jorczyk. Die Veranstaltung Entwurf digitaler Systeme soll den Studierenden einen Einstieg in die Hardwarebeschreibungssprache VHDL liefern, und praktische Fähigkeiten durch die Realisierung von Projekten vermitteln. In dem Projekt Digitale Signalverarbeitung mittels FPGA wird die Filterung eines Audio-Signals mittels FIR-Filter realisiert. Die Entwicklung erfolgt auf einem Terasic DE1-SoC Entwicklungsboard. Dieses Board ist mit einem Cyclone V SoC von Altera bestückt. In diesem SoC sind sowohl eine FPGA-Struktur, als auch ein ARM Cortex Prozessor integriert. Der ARM Cortex wird in diesem Projekt zur Kommunikation mit einem PC und zur Konfiguration des FPGA während des Bootvorgangs verwendet. Der Prozessor wird mit einer angepassten Version von Yocto Linux betrieben.



2



Systembeschreibung In dem Projekt werden hauptsächlich der Cyclone V und der Audio Codec des Entwicklungsboards verwendet. Sollten noch weitere Komponenten verwendet werden, werden diese im Lauf dieser Dokumentation erläutert. Der Audio Codec dient dazu, ein eingehendes Audio Signal zu digitalisieren und dem FPGA über eine serielle Schnittstelle zur Verfügung zu stellen und ebenfalls aus einem seriellen Signal wieder ein analoges Signal zu erzeugen. Die Initialisierung und Konfiguration des Audio Codec erfolgt dabei über den ARM Cortex Prozessor (HPS). Der FPGA nimmt die seriellen Daten des Audio Codec auf, verarbeitet diese und sendet das verarbeitete Signal seriell an den Audio Codec zurück. Um eine korrekte Aussteuerung der ein- und ausgehenden Signale zu gewährleisten, wurde eine Aussteuerungsanzeige (Meterbridge) mit dem FPGA implementiert. Die Anzeige erfolgt mit den zehn integrierten LED des Entwicklungsboards. Über die Schalter SW0 und SW1 kann die Aussteuerungsanzeige auf den rechten beziehungsweise den linken Kanal geschaltet werden, als auch vor beziehungsweise hinter den FIR-Filter.
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Abbildung 1: Systemaufbau



2.1 Signalverarbeitung Wie bereits zuvor beschrieben erfolgt die Signalverarbeitung auf der FPGA-Struktur. Da der FIR-Filter die eingehenden Daten parallel verarbeitet, müssen die eingehenden Signale zunächst parallelisiert und nach Verlassen des Filters wieder serialisiert werden. Dies erfolgt über die Entitys SERIAL_TO_PARALLEL und AUDIO_PARALLEL_SERIAL. Das Routing der Signale auf die Aussteuerungsanzeige erfolgt mit Hilfe der Bus Multiplexer BUS_MUX BM1 und BM2.



Abbildung 2: RTL Ansicht
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Inbetriebnahme Nachdem man das SD-Karten Image des Systems heruntergeladen hat, muss es zunächst mit dem Programm Win32DiskImager auf eine SD-Karte kopiert werden, welche mindestens über 8 GB Kapazität verfügt. Wenn die SD-Karte ins Entwicklungsboard eingelegt ist, müssen auf der Unterseite des Entwicklungsboards die korrekten Einstellungen an den MSEL-Schaltern vorgenommen werden, damit der Prozessor direkt von der SD-Karte booten kann. Die korrekte Einstellung ist in Abbildung 3 zu sehen.



Abbildung 3: MSEL Einstellungen



Wenn die Einstellungen korrekt vorgenommen sind und das Board mit Strom versorgt wird, bootet der HPS automatisch von der SD-Karte und konfiguriert den FPGA.
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Einrichten der Entwicklungsumgebung Während der Bearbeitung des Projektes hat sich gezeigt, dass bei der Arbeit mit einem solch komplexen System bereits während der Startphase einige Probleme auftreten können. Um eine solide Basis zu schaffen folgt eine kurze Beschreibung der wichtigsten Einstellungen und Zusammenhänge. Auf dieser Grundlage kann das vorhandene Projekt gegebenenfalls den eigenen Wünschen angepasst werden.



4.1 Herstellen der Seriellen Kommunikation Zur Übermittlung von Befehlen an den HPS wird eine serielle Verbindung benötigt. Dazu muss zunächst das Entwicklungsboard über USB mit dem PC verbunden werden. Hier ist nicht der USB BLASTER Anschluss (links) zu verwenden, sondern der UART TO USB Anschluss (oben rechts). Sobald das Board verbunden ist, sollte ein virtueller COM-Port am PC eingerichtet werden. Um eine serielle Verbindung herzustellen, muss man wissen, an welchem COM-Port das Board angeschlossen ist. Dies erfährt man am einfachsten über den Gerätemanager.



Abbildung 4: Gerätemanager



Startet man nun die Entwicklungsumgebung (Eclipse for DS-5), kann man über Window → Show View → Other ein neues Terminal Fenster öffnen.



Abbildung 5: Show View
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Abbildung 6: Terminal erstellen



Unter Settings nimmt man dann die Einstellungen entsprechend Abbildung 7 vor.



Abbildung 7: Terminal Settings



Stellt man nun eine Verbindung über Connect mit dem Board her und startet das Board neu, sollte das Entwicklungsboard folgenden Output liefern. Das Passwort zum System lautet root.
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Abbildung 8: Serieller Output nach Bootvorgang



4.2 Daten per SSH übertragen Während der Entwicklung kann es hilfreich sein, Daten per Drag and Drop auf die SD-Karte schieben zu können. Dies hat den Vorteil, dass die SD-Karte nicht ständig entfernt werden muss. Dazu wird eine SSH-Verbindung benötigt, welche zunächst eingerichtet werden muss. Eine SSH-Verbindung erfolgt über eine Netzwerkverbindung. Wird das Board direkt mit dem PC verbunden, ist darauf zu achten, dass ein Crossover-Kabel verwendet wird.



4.2.1 SSH einrichten Um ein SSH dienst einzurichten müssen die nachfolgenden Befehle ausgeführt werden. root@socfpga:cd /etc/ssh root@socfpga:/etc/ssh# cp sshd_config sshd_config.orig root@socfpga:/etc/ssh# echo PermitEmptyPasswords yes >> sshd_config root@socfpga:/etc/ssh# start-stop-daemon -K -x /usr/sbin/sshd root@socfpga:/etc/ssh# start-stop-daemon -S -x /usr/sbin/sshd Listing 1: SSH einrichten



Mit dem ersten Befehl (change directory) wechselt man in das Verzeichnis /etc/ssh/, wo die Konfigurationsdatei des SSH-Dienstes liegt. Durch den zweiten Befehl (copy) wird die Konfigurationsdatei sshd_config kopiert und als sshd_config.orig gespeichert. Der dritte Befehl (echo) setzt den Parameter PermitEmptyPassword in der sshd_config Datei auf yes. Somit ist ein Zugriff auf die SD-Karte über SSH ohne Passwort möglich. Ist dies nicht gewünscht, muss dieser Parameter auf no gesetzt werden. Um die Konfiguration zu übernehmen, muss der SSH-Dienst neugestartet werden. Dazu dienen die Befehle vier und fünf. Die Option –K steht dabei für kill und –S für start.
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4.2.2 Passwort festlegen Mit dem Befehl passwd wird das Passwort festgelegt. Durch die vorige Einstellung ist es nun möglich ein leeres Passwort zu vergeben.



Abbildung 9:Ändern des Passworts



4.2.3 Remote Verbindung einrichten Zunächst öffnet man die Remote Systems Ansicht über Window → Show View → Others.



Abbildung 10: Remote Systems Ansicht öffnen



Über den Button Define a new connection to a remote System erstellt man eine neue SSH Only Verbindung. Im nachfolgenden Fenster wird die IP-Adresse des Entwicklungsboards eingetragen.
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Abbildung 11: SSH Verbindung einrichten



Ist die IP-Adresse nicht bekannt, erhält man nähere Informationen über die Serielle Verbindung, indem man den Befehl ifconfig eth0 eingibt. Die Antwort des Boards sollte ähnlich der in Abbildung 12 aussehen.



Abbildung 12:IP Adresse des Entwicklungsboards



Nach Bestätigen mit Finish wird eine neue Verbindung angelegt. Damit diese problemlos funktioniert, muss noch der Benutzer geändert werden. Über die Eigenschaften der Verbindung kann der Standardbenutzer eingestellt werden.
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Abbildung 13: Verbindungseigenschaften



Der Standardbenutzer sollte hier root lauten.



Eine Verbindung zum Entwicklungsboard ist nun möglich und man sollte vollen Zugriff auf das Dateisystem der SD-Karte erhalten.
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Abbildung 14: Remote Zugriff auf SD-Karte



4.3 IP-Adresse Festlegen Möchte man regelmäßig per Remote Zugriff auf Dateien zugreifen ist es sinnvoll, eine feste IP-Adresse für das Board einzurichten. Um dies zu erreichen, muss die Konfiguration in der Datei interfaces geändert werden. Diese befindet sich im Verzeichnis /etc/network/.
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Abbildung 15: Interfaces



Hier müssen die Einträge folgendermaßen geändert werden. Die Zeile iface eth0 inet dhcp muss mit einer Raute auskommentiert werden. Dies verhindert, dass das Board eine IP-Adresse über einen dhcp Dienst bezieht. Nun muss die Datei um auto eth0 iface eth0 inet static address 169.254.2.136 netmask 255.255.0.0 erweitert werden. In diesem Teil wird festgelegt, dass die eingetragene Adresse eine statische IP ist.
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Abbildung 16: Interfaces Einträge



4.4 FPGA beim Booten konfigurieren Wird die Stromversorgung eines FPGA getrennt, verliert dieser auch die gesamte Konfiguration. Damit beim Bootvorgang der FPGA konfiguriert wird, sind einige Schritte nötig um dies zu einzurichten. Dazu benötigt man ein Programm, welches die Konfigurationsdaten in den FPGA lädt und ein Skript, welches während des Bootvorgangs ausgeführt wird. Das Programm befindet sich auf der SD-Karte im Verzeichnis /home/root/fpga_config/ Dort befindet sich ebenfalls die Konfigurationsdatei (.rbf) für dieses Projekt. Möchte man den FPGA manuell konfigurieren, erreicht man dies über das serielle Terminal mit dem Befehl ./hps_config_fpga soc_system.rbf Soll die Konfiguration automatisch erfolgen benötigt man zunächst eine Skript-Datei, welche genau diesen Befehl ausführt. Skript-Dateien, welche beim Booten ausgeführt werden befinden sich in der Regel im Verzeichnis /etc/init.d
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Die Skript-Datei zu diesem Projekt ist die startup.sh Datei. Der Aufbau ist in #!/bin/bash echo "Starting SoC initialization" echo "******************************" cd /home/root/fpga_config/ echo "Configuring FPGA fabric" ./hps_config_fpga "soc_system.rbf" cd /home/root/ echo "Routing I2C multiplexer" ./i2cmux "hps" echo "Initializing audio codec" ./audioinitialize echo "******************************" echo "Initialization finished" exit 0



Listing 2 zu sehen. Besonders wichtig bei einer Skript-Datei ist die erste Zeile. Diese beinhaltet eine sogenannte Magic Line (Shebang). Die Zeichenkombination #! gefolgt von einem Parameter legt fest, um welchen Dateityp es sich handelt. In diesem Fall ist ein Bash-Skript gemeint. Fehlt diese Zeile, wird das Skript nicht korrekt ausgeführt. Das Keyword echo gefolgt von einem String sorgt während der Ausführung dafür, dass der angegebene String über die Konsole ausgegeben wird. Um nun die Konfigurationsdatei zu laden, wird exakt wie beim manuellen Laden vorgegangen. Zuerst wird das Verzeichnis mit cd (change directory) gewechselt und danach das Konfigurationstool ausgeführt. Wichtig dabei ist, dass die Programmausführung mit der Kombination ./ gestartet wird und der Parameter als String, also in Anführungszeichen, übergeben wird. Ist das Skript abgearbeitet, wird dies mit dem Befehl exit 0 verlassen. Sollten während der Ausführung des Skriptes Fehler auftreten, ist der Exitcode von Null verschieden.
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#!/bin/bash echo "Starting SoC initialization" echo "******************************" cd /home/root/fpga_config/ echo "Configuring FPGA fabric" ./hps_config_fpga "soc_system.rbf" cd /home/root/ echo "Routing I2C multiplexer" ./i2cmux "hps" echo "Initializing audio codec" ./audioinitialize echo "******************************" echo "Initialization finished" exit 0 Listing 2: startup.sh



Damit dieses Skript beim Booten ausgeführt wird, muss dem System mitgeteilt werden, dass ein weiteres Skript geladen wird. Dazu führt man den Befehl update-rc.d startup.sh defaults aus. Beim nächsten Neustart wird nun das Skript automatisch ausgeführt und die FPGA Konfiguration geladen.
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Wichtige Zusammenhänge Gerade während der ersten Gehversuche fehlen Informationen über fundamentale Zusammenhänge, welche nicht hinreichend dokumentiert sind. Dieser Abschnitt soll eine knappe Übersicht über die wichtigsten Zusammenhänge liefern, um nicht zu Beginn schon die Motivation zu verlieren.



5.1 QSYS und Eclipse Um die Funktionalität des HPS zu erweitern verwendet man QSYS. QSYS ist ein integriertes Tool in der Quartus Entwicklungsumgebung. Hier werden zum Beispiel Schnittstellen zwischen dem HPS und der FPGA-Struktur definiert. Diese kommunizieren dann später über einen gemeinsamen Speicher. Die Start (Base) und End-Adressen des Speichers sind in Abbildung 17 zu sehen.



Abbildung 17: QSYS



Wenn nun über den HPS auf diesen Speicher zugegriffen werden soll, kann man diese Adressen händisch in eine Header-Datei übertragen, oder ein speziell dafür geschriebenes Tool verwenden. Dieses Tool ist ein Kommandozeilenprogramm, welches man über die Nios II Command Shell erreicht.



Abbildung 18: Nios II Command Shell



Zunächst wechselt man in das Verzeichnis, wo die .qsys-Datei zu dem HPS-System abgelegt ist. Danach führt man den Befehl 17/36



./generate_hps_qsys_header.sh aus. Nach erfolgter Erstellung einer Header Datei sollte die Ausgabe der Konsole wie folgt aussehen.



Abbildung 19:Header Erstellung



In dem Verzeichnis sollte sich nun eine Datei mit dem angegebenen Namen befinden, welche Compilerdirektiven mit den entsprechenden Speicherbereichen beinhalten.



Abbildung 20: Compilerdirektiven mit Speicherbereichen
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Software Dieser Abschnitt soll einen Einblick in die Software geben, welche benötigt wird, um die gewünschte Funktionalität herzustellen. Der Fokus wird dabei auf die Programme gelegt, welche im Startskript aufgerufen werden. Da das Konfigurationstool hps_config_fpga von Terasic übernommen wurde und für beliebige .rbf-Dateien verwendet werden kann, wird darauf nicht weiter eingegangen. Vielmehr sind es i2cmux und audioinitialize, welche bis hier noch keine Aufmerksamkeit bekommen haben. Das Entwicklungsboard verfügt über einen Analogmultiplexer. Dieser ermöglicht es, periphere Bausteine, wie den Audio Codec, sowohl vom FPGA, als auch vom HPS über I2C anzusprechen. i2cmux ermöglicht es, diesen Multiplexer zwischen beiden Strukturen umzuschalten. audioinitialize dient dazu, den Audio Codec nach Benutzervorgaben zu initialisieren. Dies könnte auch mit Hilfe eines IP-Cores von Altera erfolgen, es existiert aber ein ausschlaggebendes Argument dies nicht zu machen. FPGA-Ressourcen sind immer begrenzt und im Vergleich zum Speicher sehr wertvoll. Erfolgt die Konfiguration über den HPS, wird lediglich Speicher auf der SD-Karte belegt und die FPGA-Struktur bleibt unberührt. Ein weiterer Grund ist die Flexibilität. Während Änderungen in der FPGA-Struktur immer eine komplette Synthese mit sich zieht (Quartus Lite), muss eine Änderung am Programm lediglich neu kompiliert werden.



6.1 i2cmux Der I2C Multiplexer wird über einen bestimmten Pin des Cyclone V angesteuert. Dieser wiederum kann über das Schreiben eines bestimmten Registers angesprochen werden. In Unix basierten Betriebssystemen muss dafür nicht extra ein neuer Treiber geschrieben werden. Man kann direkt über ein Speicherabbild auf den entsprechenden Speicherbereich zugreifen. Dazu befindet sich im Verzeichnis /dev/ die Datei mem. Diese Datei stellt quasi eine Kopie der Hardwareregister dar. Das Angenehme daran ist, dass man auf sie zugreifen kann, wie auf eine Textdatei. Man sollte nur wissen, in welchen Bereich man hineinschreiben möchte/darf und in welche nicht. Der Zugriff darauf erfolgt immer auf die gleiche Weise. Zunächst wird die Datei mit dem Befehl open() geöffnet und ein Handle angelegt, welches später verwendet wird. MEMORY_MAP_FILE_NAME ist dabei die Adresse der Speicherabbilddatei. O_RDWR und O_SYNC sind Flags, welche Zugriffseigenschaften der Funktion steuern. fd = open(MEMORY_MAP_FILE_NAME, (O_RDWR | O_SYNC));



Anschließend wird über den Befehl mmap() ein bestimmter Bereich dieser Datei in den Speicher gemappt. Der Befehl gibt ein Handle zurück, mit dem später der Speicher angesprochen wird.
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virtual_base = mmap(NULL, HW_REGS_SPAN, (PROT_READ | PROT_WRITE), MAP_SHARED, fd, HW_REGS_BASE);



*i2c_switch_0_addr ist hier ein Pointer, der die Adresse von virtual_base enthält. HPS_I2C_CONTROL ist das Bit im Speicher, welches den Pin des I2C Multiplexers steuert. In dem unten zu sehenden Beispiel wird dieser Speicherbereich mit einer 1 beschrieben. *i2c_switch_0_addr |= HPS_I2C_CONTROL;



Möchte man den Speicherbereich zurücksetzen, muss die Zuweisung wie folgt aussehen. *i2c_switch_0_addr &= ~(HPS_I2C_CONTROL);



Möchte man zu Testzwecken auf das Programm zugreifen wurden die Befehle hps und fpga implementiert. Man kann den Multiplexer also über das serielle Terminal mit den Befehlen i2xmux fpga und i2cmux hps auf den FPGA beziehungsweise den HPS routen.



Abbildung 21: I2C Multiplexer



6.2 audioinitialize Der Zugriff auf die I2C verantwortlichen Register erfolgt auf die gleiche Weise wie in 6.1 beschrieben. Zur Initialisierung wird eine Reihe von Befehlen an den Audio Codec übermittelt. Da der Audio Codec ein Write Only Device ist, bietet es sich an, alle Register auf einen bekannten Wert zu initialisieren. Dazu werden in der Headerdatei audio_codec.h diese Register definiert und an den Coden übertragen.
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#define #define #define #define #define #define #define #define #define #define



REG_00_DEFAULT REG_01_DEFAULT REG_02_DEFAULT REG_03_DEFAULT REG_04_DEFAULT REG_05_DEFAULT REG_06_DEFAULT REG_07_DEFAULT REG_08_DEFAULT REG_09_DEFAULT



0b000010111 0b000010111 0b001111001 0b001111001 0b000010010 0b000000000 0b000000010 0b001001011 0b000000000 0b000000001 Listing 3: audio_codec.h



Damit man sich nicht jedes Mal mit dem Datenblatt quälen muss, wurde eine ExcelDatei erstellt, welche die Konfiguration vereinfachen soll.



Abbildung 22:Audio Codec Excel-Tool



Alle Einstellmöglichkeiten der vorhandenen Register wurden mit Drop Down Listen realisiert. Wird eine Einstellung geändert, findet die entsprechende Konfiguration der Register statt. Ist die gewünschte Konfiguration vorgenommen, müssen die Definitionen (oben rechts) in die Headerdatei kopiert werden. Nach erneuter Kompilierung wird der Codec mit den gewünschten Einstellungen initialisiert.
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VHDL Dieser Teil der Dokumentation soll den Aufbau und die Funktion des DSP-Teils detaillierter beleuchten. Dabei wird ein besonderer Fokus auf synthetisierbaren VHDL-Code gelegt, welcher frei von Latches ist. Des Weiteren werden Entitys, wo es sinnvoll ist, generisch gestaltet. Dadurch sind diese für andere Anwendungen skalierbar.



7.1 Bus Multiplexer Ein generischer Bus Multiplexer lässt sich relativ leicht in VHDL realisieren. Die Einund Ausgänge werden über Vektoren realisiert INPUT und OUTPUT. Dem Ausgangsvektor wird ein Bereich des Eingangsvektors in Abhängigkeit von der anliegenden Adresse zugewiesen. architecture BEHAVIOUR of BUS_MUX is begin OUTPUT 
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